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Introduction 
It’s great you are reading this text and we hope you find it most useful. Please use this text in 
conjunction with the web site at www.itelya.com. This text will normally be used as an 
accompaniment to classroom lessons. It is also used through internet learning along with 
questions and answers via a forum. 
 
This course will go a long way in assisting you in developing the skills needed to work with 
Word efficiently. You will need to practice and use the features regularly to become proficient 
with this program. 
 
Disclaimer 
Every effort is made to provide accurate and relevant information and assistance, which is 
presented in an organised and considered structure. However the author takes no 
responsibility for careless use of the information that may result in losses of any sort. 
 
Learning outcomes 
This text is to be used in conjunction with the classroom activities or via online web activities 
to study the program MS Word.  
 
What we want to achieve is; 
 

• Be exposed to IT (information technology) generally 
• Understand the GUI of Word 
• Understand the tools of Word so as to produce quality documents efficiently. 

 
This course will run through all the features of the program from the basic features to the 
more complicated and less used options. It is best to start at the beginning and work your way 
through for later features will presume you understand items covered earlier. 
 
Assessment 
To ensure your learning and understanding of the program you will need to actively participate 
with questions and discussion and share you efforts with the group or on the web site. It is 
suggested that you practice as you go as you learn more throughout the course.  
 
The Author 
I have been associated with computers for some 25 years and I studied formally at university 
for two years doing a Bachelor of Buss with computing as the major.  I hold a Certificate lV in 
Training & Assessment & a Diploma in Training & Assessment and I am currently enrolled in a 
Certificate lV in IT so I can formalise my knowledge. I have combined my passions for 
photography, computing, and natural desire to teach, and designed this course on MS Word. 
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Part 1 
What is Word. 
Word is the most popular Word Processor program used today and represents an industry 
leader in the field. Word is a program that manipulates text and graphics to produce letters 
and documents.  
 
The following table is taken from the Microsoft Web site; 
http://office.microsoft.com/en-au/word/default.aspx?ofcresset=1 
 
The table shows the hardware requirement to run Word 07 and most computers of today 
would have these specifications or better. 

Microsoft Office Word 2007 
Component Requirement 

Computer and processor 500 megahertz (MHz) processor or higher 

Memory 256 megabyte (MB) RAM or higher1 

Hard disk 1.5 gigabyte (GB); a portion of this disk space will be freed after installation if the original 
download package is removed from the hard drive. 

Drive CD-ROM or DVD drive 

Display 1024x768 or higher resolution monitor 

Operating system Microsoft Windows XP with Service Pack (SP) 2, Windows Server 2003 with SP1, or later 
operating system2 

Other Certain inking features require running Microsoft Windows XP Tablet PC Edition or later; speech 
recognition functionality requires a close-talk microphone and audio output device. 
 
Publications can be sent using Office Outlook 2007, Outlook Express 6.0, or Windows Live Mail; 
recipients can view in a variety of e-mail clients and Web-based services. 
 
Internet Explorer 6.0 or later, 32 bit browser only. Internet functionality requires Internet access 
(fees may apply). 

Additional Actual requirements and product functionality may vary based on your system configuration and 
operating system. 

1 Grammar and contextual spelling in Word is not turned on unless the machine has 1 GB memory. 
2 Office Clean-up wizard not available on 64 bit OS. 
 
 

Buying Word 
Word will often come with the MS office group of programs, and obtaining it this way generally 
represent good value as you also get the other ‘essential’ office programs such as a 
database(Access), a spreadsheet (Excel), and an email and organiser(outlook) program. There 
are different versions available and educational institutions often have excellent deals if you 
are currently studying. 
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Running word 
To run word it is usual to click on the Word Icon on the desktop. This icon is as shown with a 

W as its main feature. If you do not have a desktop icon then go to 
your Start button - all programs – where you will either find 
Word or Office – Click on the Word icon to run word or click 
on Microsoft office then on the Word Icon. You will then be 
presented with the screen below. 
 

 

GUI (Graphical User Interface) of Word 
Let’s look at the screen used by Word 07. It has changed somewhat from the previous version 
of Word to use a menu system based on a Ribbon, tabs, and groups. 
 
Office Button  Quick Access Tool Bar  Tabs 
 
 

Close, Maximise, 
Minimise  
 
The Ribbon of 
groups 
 
 
Down arrow 
revealing more 
options 
 
 
Groups 
 
Cursor bar 
 
Document Window 
 
 
Browse options 
 
 
 
Zoom options 

 
 
 
Document Information (status bar)   Document view Options 
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Menu commands 
Using your mouse you can click along the various tabs of Home, Insert, Page Layout, etc. Each 
Tab has a new set of options that appear on the ribbon as you select the Tab. 
 
With the Home tab selected you have groups of Clipboard, Font, Paragraph, Styles and Editing 
as Shown. 
 

 
 
If you press the Alt key on the keyboard then numbers and letters appear next to menu 
options. This is useful if you mouse stops working or you come proficient at using the 
keyboard. For instance to save a file without the mouse do this; 

Press the alt key 
Press the F key 
Press the A key and so on. 

To quit the feature press the Alt key again or click with the mouse. 
 

Another feature which is used extensively in 07 is the use of the right mouse button click. 
When you press the right mouse button a context sensitive menu appears which will often 
contain the command you are looking for. 
 
Commands also have keyboard shortcuts, which allow you to use a key combination rather 
than a mouse click. See the Micro Soft tutorial at  
http://office.microsoft.com/training/training.aspx?AssetID=RC101562731033&pid=CH102247
601033 
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Rulers tabs and indents. 
Tabs are set markers on the ruler and when you press the tab key on your keyboard the 
cursor jumps to the next tab marker. Tab stops as they are known are set by default at every 
1.27cm across the page and are shown by the little black vertical line.  
 

The ruler is shown at the top and left of the document. 
If the ruler is not showing you can turn on the feature 
by going to the option View tab – Show Hide Group 
– check the box next to Ruler. As you can see below 
 

You can add your own tabs to the ruler. 
Notice the small L shaped icon in the 
left corner of the ruler. This is a left tab 
marker. With this marker displayed you 
can click on the ruler anywhere to 
create your left tab stops. To remove a tab stop move your mouse to it and drag it off the 
ruler. Dragging is a technique with the mouse. To drag you select the object with the mouse, 
hold down the left mouse button and keep it held down while you move the mouse.  
 
Tabs stops are useful in lining up items such as numbers like this; 
Nunmber1   100 
Next number  101 
Very next Number  200 
And again   203 
The numbers have been pushed across to a tab mark by pressing the tab key on the 
keyboard. 
 
There are other tab options but we will discuss these when we have more knowledge about 
justification. 
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Open a Document 
Ok let’s go through the process of opening an existing document from the hard drive. 

 
The open command is underneath the Office 
Button at the top left of the screen. You will 
notice other commands here as well such as 
New, Save, Save As and so on. At the bottom 
of this window there are commands for Word 
Options and Exit Word. We will look at all of 
these in due course. Notice also where is 
says recent documents. These recent 
documents are files we have worked on, well 
recently, and this list allows us to find them 
quicker than if we were to navigate our hard 
drive to find the file. 
 
For now let’s click on Open. When you do this 
you are presented with the folder structure 
that is on your computer. You will need to 
navigate to where the file is that you wish to 
open up. If you don’t know how to do this 
then go and find the tutorial ‘Navigate the 
folder System’ at www.itelya.com. So find 
the file open a document ex.docx. 
 
We should appreciate here what the .docx 
means. The three letter file extension used 
by Word 03 is .doc. Word 07 uses a four 
letter file extension of .docx. This identifies 
the file as one that is created by Word 07 
and may contain features that are not 
understood by the Word 03 version. The 
significance of this is that if you give a file to 
someone who does not have word 07 then 
they may have problems opening the file. 
 
If you look at the bottom of the open window 
you will see a box that says, in the example 
opposite, all files. This means that as we 
navigate the folder system looking for files 
that files of all types, such as picture files, 
spreadsheet files, word 03 files, and so on 
will be displayed. If you press the small black 
down arrow in the All Files box you will get a 
list of many file types that the program 
supports. These file types may be a bit 
foreign to you at this stage but we will 
address then as needed. 
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 The ones to note now are Word 97-2003 Documents (*.doc), All files as we have mentioned, 
and All Word Documents. 
 
 

 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Ok, continue the open process and the file will be opened into Word.  
 

Document Navigation Keys 
Finding your way around a document is most important especially when the document 
becomes large. Scrolling with the mouse is most efficient, but also are the following keyboard 
keys; 

• Page Up (PGUP) and Page down (PGDN) - Moves a screen page up or down 
• The End key – moves your cursor (the flashing black line or insertion point for text, 

etc) to the end of the line. 
• The Home key -  moves the cursor to the start of the line 
• Ctrl Home – moves the cursor to the top of the document 
• Ctrl End – moves the cursor to the bottom of the document. 
• The arrow cursor keys to move left, right, up or down 
• Esc key – used often to get back or close an open box or get out of a ‘spot’ 

 
The above key presses are the ones I use most. 
 
 You can also use; 

• Ctrl Page Up – Jump to the previous page 
• Ctrl Page Down – Jump to the next page 
• Ctrl right arrow – Move insertion point (flashing cursor) to the right one word 
• Ctrl left arrow – Move insertion point (flashing cursor) to the left one word 
• Ctrl up or down arrow – Move insertion point up or down a paragraph. 

 
But this will do us for now. 
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Cursor bars 
You can use the cursor bars when visible to scroll your document. The one on the right had 
side of your screen is normally always there. A quick way to make the bottom one visible is to 
zoom up your document.  
 
 

Cursor bar 
 
Or just click in the 
bar 
 
Slider Buttons 
 
 
Navigation arrows 
Previous page 
Next page 
 
Other document 
browsing options 

 

Zooming 
Try this; 

• Click the View Tab 
• Find the Zoom group 
• Click the Zoom tool 
• Click on 200% and ok 
• You now have a horizontal scroll bar at the bottom of the screen 
• In the Zoom group click on 100% and we will be back to normal 

 
A quicker way to do this is via the zoom option at the bottom right of the screen. 

 
Options here are click on the 100% to bring up the menu as 
before, click on the – or + to change, or click on the slider bar 

or drag the slider.  Cool Eh. 
 

Views 
The main view we use is the Print layout view and this is the default.  
The view options available to us are; 

• Print Layout. I would regard this as the normal view and is similar to the way the 
document will print on paper.  

• Reading Full screen. This is supposed to make reading the document easier by 
enlacing the characters but in the case of this document it is inefficient. 

• Web Layout 
• Outline – editing assistance 
• Draft 

These can be accessed via the status bar, shown below, or via the View tab – Document 
Views Group.  
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Editing 
Edit text 
 
We edit text in a document in various ways. Some of the tools we use are; 
 

• Selecting text by dragging the mouse over the relevant text 
• Selecting text by clicking in the margins with the mouse 
• Selecting text by using key press combinations 
• Copy and or cut and then pasting 
• Dragging 
• Typing over existing text 
• Relocating the insertion point and then typing 
• Using the enter key to move down a line 
• Selecting formatting options of the menus i.e. Bold 

 
So let’s try some simple Editing. 
Open up edit text ex.docx. 
 
Clicking in the Margin 
Look closely at the screen shot below. Notice where the white arrow is, it is positioned in the 
margin area of the document. I want you to position your mouse cursor in the same location 
and then click once. This will highlight or select the whole line adjacent to the mouse cursor. 
Now double click and this will select the whole paragraph. Now triple click (a bit tricky) and 
this will select all the text. 
 

 
Clicking in the text 
A similar method can be used in the text, click in the 
text once, then double click to select a word, and 
triple click to select the paragraph 
 
Other ways to select 
Click in front of a word, then hold down the shift 
key, move along a couple of words and click.  
 
Ctrl Click on a sentence to select the whole 

sentence. Essentially though, I generally always use the mouse to select text. Click at the start 
of the area to select, and then drag you mouse directly to the end of the section you are 
selecting. 
Do this in the example document. 

• Click with your mouse just before the word Macro (the last sentence in the document).  
• Click and hold the Left Mouse Button down and move you mouse directly toward the 

end of the sentence. (dragging) 
• Move the mouse pointer so it is inside the selected area.  
• Press the Del (delete) key on the keyboard and the select text is deleted. 
• Press the undo icon to undo the delete 
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Authors preferred Method 
As said earlier I generally always use the mouse to select text. A way of working in a word 
processor is to first write the information and then worry about tidying up the document 
editing later. Such items as spell checking, paragraph formatting, font and heading changes, 
and so on, can be done as a separate exercise.   
 
Note  
The location of the Spell Checker is under the Review Tab in the first group called Proofing. 
 

Hidden symbols 
All programs have what is known as a file type. We have mentioned that Word 07 users the 
file extension .docx and this identifies the file structure as being particular to this version of 
the program. When we save our file to the hard drive it is saved in the file structure as defined 
by the program. In order for the program to save in its file such things as spaces and blank 
lines, paragraphs, different size text and so on there needs to be some way of identifying this. 
For us users we can see some of how this works by turning on or off formatting symbols. This 
is available form the Home tab – paragraph group – Icon top right as shown. 

  
The option is a toggle, click once to turn on, click again 
turn off. 
 
 
 

 
The text below shows some formatting marks.  
Space is shown by a dot and a paragraph is the symbol shown.  

 
 
 
 
 
 
 

 
 
Sometimes a document can do unpredictable things and by turning the markers on this will aid 
your editing considerable in such a case. 
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Saving 
When you save a document to the hard drive for safe keeping you have two options, namely 
Save and Save As. If this is a new document that you wish to save and has not yet been saved 
then you will be presented with a Save As screen so that you can give the document a name. 
If it is an existing document that you have opened up and you are now re saving then you can 
use the Save option on its own. This will use the same file name and overwrite the old 
document on the hard drive.  
 
NB – If you want to keep the previous version of the document as well as the current version 
then you will need to use Save As and give the current version a different name. 
 
The Save As and Save commands can be found by clicking on the office button. A save option 
is also available on the quick Access toolbar. 
 
 
Click on the Office Button for Save As 
 
   Quick access save option 

 
It important to 
regularly save you 
documents to the 
hard drive to prevent 
data loss. Word has 
Auto save features 
that can be set 
through the Word 
options section. The 
options to auto save 
is set to on by 
default. To alter the 
settings you can do 
this; 
Select office button – 
word options (bottom 
of window) – save – 
check the save auto 
recovery information 
box. Alter other 
conditions as needed. 
 
 
 
 
 
 
 
 

 
To Be Continued 
End of Document 


